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Outlook 2000 Email
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Starting Outlook XE "Starting Outlook" 
To start Outlook double click on the Microsoft Outlook icon on your Windows desktop.

OR

[image: image14.png](@ Inbox - Microsoft Dutlook |- [5]x]

[ e Tt o Foves Toob acions b

| Gtiew + | & DY X | @oreply oRenly ol 4@ Foruard | jsendReceive | ZyFind Ggoraenee [ @ | @)

Outlaok Shortcuts &

|Subject

Received + 5

O 6 Bedwell G511 JanetE RE: ClickaLearn Class Mon 10/30/00 4:29 PM
A Erickson GS09 Cheryl R Newsletter Mon 10/30/00 1:52 P

Calendar

-

You have been scheduled to attend a New Employee Orientation L&
on Monday, and Tuesday, 6th, & Tth November, beginning at

0830, Monday in the CBT Room (2nd deck),and 0800, Tuesday in
the CG's Conference Room (3* deck). L

At 0830 on Monday you will begin the Computer Based Training
(CBT) on the 2° deck to learn about MCRSC's unique databases.

As the schedule below indicates, you will begin on Tuesday
taking a “walking tour” through MCRSC while receiving cross
education information. You will be shown the tasks and
responsibilities of all divisions within the Command and how

My Shorcuts
Other Shoteuts

 tems

SA5tort| [ imbon - Microsoft Ol ] Oulook 2000 doo - ites. | BT Document2 - Micisott Word RO 2 HIB siomm





You can click once on the Microsoft Outlook icon on your Programs Toolbar.

OR

You can click on the Start menu, glide to Programs, and click on Microsoft Outlook.

Outlook by default starts in the Inbox with the Preview Pane.
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The Preview Pane needs to be shut to help prevent viruses.

To shut the Preview Pane, click on View then Preview Pane.

Exiting Outlook XE "Exiting Outlook" 
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To remain connected to the mail program, click on the Minimize button in the upper-right corner of the window. 

To disconnect from the mail program, choose File then select Exit and Log Off.
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You can also disconnect from Outlook by clicking on the Close button in the upper-right corner of the window.
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Using the Outlook Bar XE "Using the Outlook Bar" 
The Outlook Bar is a tool you can use to quickly change folders in Outlook.  The icons in the Outlook Bar represent the folders available to you and provide shortcuts to getting to the contents of those folders.

Three shortcut groups are located with the Outlook Bar:  Outlook Shortcuts, My Shortcuts, and Other Shortcuts.

	Outlook Shortcuts Group XE "Outlook Shortcuts Group" 

	Item
	Description
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	Provides an overview of your day.  It lists the email you received that day, your appointments, and your scheduled tasks.  This can be customized to start up when first opening Outlook.
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	Allows you to receive, send, and sort email messages.  In the Inbox you can reply to messages and forward messages to other users.
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	Allows you to schedule appointments, meetings and events, and track tasks status.  In Calendar, you can use the Date Navigator to view activities by day, week, or month, or in a list.  You can also use the Meeting Planner to schedule meetings with others.

	[image: image4.png](@ Inbox - Microsoft Dutlook |- [5]x]

[ e Tt o Foves Toob acions b

| Gtiew + | & | DY X | @oreply oRenlytol 4@ Fornerd | FsendReceive | Z5Find

rganze || )

Calendar

-

My Shorcuts
Other Shoteuts

[

Whithead Larry R
Bedwell GS-11 Janet E
Erickson GS09 Cheryl R

|Subject

New Employee Orientation
RE: ClickaLearn Class Mon 10/30/00 4:29 PM
Newsletter

Received + 5

Tue 10/31/00 6:48 AM

Mon 10/30/00 1:52 PM

—ori
From: Or
Sent
To: mFR
Diane I;
Subject:

ginal Hessage-
tega GSO7 Terry L

Tuesday, October 31, 2000 8:25 AN

MISSO Civilian; NFR MISSA Civilian;

Gurklies GS07 Elizabeth I
FU: OPEN SELSON NOTICE

Please make widest distribution possible.

Please reviev the Benefits Administration Letter 00-404 from OPN, attached

HCSA Civilians; Lanahan G509

4 tems

S 5tart| [ imbor - icrosoft Outl... B)Dosument] - Mictosoft Word] ) 0utook 2000 doc - Micos.

RO 2B OB sazan





	Allows you to create and maintain a database of contact information, including the mailing address, web address, and three email addresses.  Through Contacts you can track a contact’s activities, correspond with contacts, and visit a contact’s web page.
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	Allows you to schedule, assign, and track tasks.  You can also manage recurring tasks and organize and prioritize tasks.
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	Allows you to automatically record activities with contacts and track activities over time.  You can also use Journal to locate information or files based on the date they were last used.  Microsoft does not recommend using.
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	Allows you to record special concerns on issues you may need to address later.  Outlook Notes are like virtual paper sticky notes.
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	Stores all items that are deleted or removed from Outlook.  Like the Windows Recycle Bin, the Deleted Items folder must be emptied on a regular basis.


	My Shortcuts Group XE "My Shortcuts Group"  Folders

	Item
	Description
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Drafts
	Contains messages you have started but not sent.
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Sent Items
	Stores all messages you’ve sent.
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Outbox
	Contains messages to be sent.
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Journal
	Keeps track of your activities in Outlook.  Microsoft does not recommend using.


The Other Shortcuts Folders XE "Other Shortcuts Folders" 
The Other Shortcuts group contains folders that are on your computer but not within Outlook:  My Computer, My Documents, and Favorites.  You can access a document or information in any of those areas so that you can attach it to a message, add notes to it, or otherwise use it in Outlook.

Customizing Outlook Today XE "Customizing Outlook Today" 
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Click on Outlook Today to provide a one-stop preview of your day.  Click on Customize Outlook Today to display the Outlook Today Options window:  

The following table describes the options for customizing Outlook Today:

	Option
	Description

	Startup
	Allows you to have Outlook default directly to the Outlook Today view when you launch the program.

	Messages
	Allows you to define exactly which folders to display for message count in Outlook Today.  By default Outlook Today checks the Inbox, Outbox, and Drafts folder.

	Calendar
	Allows you to determine how many days to display in the Outlook Today calendar.  You can choose from one day to one full week.

	Tasks
	Allows you to determine which tasks to display in Outlook Today.  You can select only the current day’s tasks, or all tasks.  This option also allows you to define the order in which the tasks appear.  You can sort tasks in ascending or descending order based upon up to two criteria.  The available categories for task sorting include:  Importance, Due Date, Creations Time and Start Date.

	Styles
	Allows you to choose a specific viewing style for Outlook Today.   You can choose from Standard, Standard (two column), Standard (one column), Summer, or Winter styles.


Change the options you want then click on Save Changes at the top of the pane.
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Using the Folder List XE "Using the Folder List" 
Outlook provides another method of viewing the folders within Outlook and your system:  the Folder List.  It displays the folders within any of the three groups (Outlook Shortcuts, My Shortcuts, or Other Shortcuts).  From the list, you can select the folder you want to view.

To display the Folder List, click on the View menu then click on Folder List.
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OR

Click on the beside Inbox on the Folder banner.
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[image: image23.wmf]To keep the Folder List open, click on the pushpin button              in the upper corner of the Folder List to “pin down” the list in the Outlook window.  To close the Folder List, click on the Folder List’s Close button.

[image: image24.wmf]Creating New Folders XE "Creating New Folders" 
To keep your stored messages organized, you can create new folders and subfolders in which you can store messages.  

To create a new folder:

1.
In the Folder List, right-click on the folder in which you want to place your new folder, and click on New Folder.

OR

You can click on the File menu, point to New, and click on New Folder.  Outlook opens the Create New Folder window.
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2.
In the Name box, type the name for the new folder.  (If necessary, select Mail Items from the Folder contains list.)

3.
Click on the folder to which you want to add the new folder in the Select where to place the folder list.

4.
Click OK.  

Outlook may display the Add Shortcut to Outlook Bar window.
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5.
If you want to add a shortcut icon to your new folder in the Outlook Bar click on Yes.  Outlook displays the new folder and the shortcut in the My Shortcuts group in the Outlook Bar.

6.
If you clicked No, and later want to place the folder name on the Outlook Bar; with the folder list open, click on the folder and drag to the Outlook Bar.

Creating and Sending a Message XE "Creating and Sending a Message" 
To create a New Mail Message:
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1.
 While in the Inbox, click on the New Mail Message button.

OR

2.
You can click on the File menu, point to New, and click on Mail Message.

Outlook displays the Untitled – Message window:
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3.
Type the name of the person to whom you want to send the message in the To box.

OR

You can also type an Internet email address in the To box, i.e. salazarml@mfr.usmc.mil.

OR
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Type part of the name in the To box, then click on the Check Names button on the Standard Toolbar.
Outlook will complete the name or provide you with a dialog box with close matches, which you can choose the name you want.

OR

Click on the To button to open the Select Names window.  The names listed should be from your Global Address List.
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Here you are able to start typing the last name of the individual in the Type Name or Select from List: field.  When the name of the individual is highlighted press Enter or click on the To button.   You can enter as many Message Recipients that you want in the To:

To enter names in the Cc: (Courtesy Copy), highlight the individual’s name and click on the Cc.  You can enter as many Message Recipients that you need in the Cc:

To enter names in the Bcc: (Blind Courtesy Copy), highlight the individual’s name and click on the Bcc.  You can enter as many Message Recipients that you need in the Bcc:

Then, click OK to return to the message.

4.
Either press TAB to go to the Subject field or click in the blank.

5.
Either press TAB to go to the body of the message or click in the large box below the Subject box.

6.
When you are finished, click on the Send button.  Outlook will send the message and return to the Inbox.

When you send a message, Outlook saves the message in the Outbox folder until the message is actually delivered to the server.  Once the message is delivered.  Outlook stores a copy of the message in the Sent Items folder.

Return Receipt XE "Return Receipt" 
To request a return receipt that the recipient received and/or opened a message, in your new message before sending:
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1.
Click on Options to open the Message Options window.


2.
Click here if you want a receipt for when this message is delivered.



3.
Click here if you want a receipt for when this message is read.




4.
Click the Close button.

Saving a Message XE "Saving a Message" 
Outlook allows you to save the message without sending it so that you can come back to it later.  Do the following to save an unsent message:
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1.
From the Untitled – Message window, click on the Save button on the Standard Toolbar.
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2.
Click on the message window’s Close button.

Outlook saves the message in your Drafts folder (which is located in the My Shortcuts Group).

When you want to complete it later, go to your Drafts folder and double-click on the message to open it.  Outlook displays the following within the header:
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Sending a Message with an Attachment XE "Sending a Message with an Attachment" 
To attach a file, use the following steps:

1. Create a new message or open an existing message.
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Move to the location in the body of the message where you want to attach the file.

3. Click on the Insert/File menu.

OR
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Click on the Insert File button on the Standard Toolbar. 

NOTE:  Click on the file that you want to attach to the message.  If the file that you want to attach is not in the current drive or in the current folder, click on another drive or folder in the Look in list or double-click on the folder in the large list box.

Reading Mail XE "Reading Mail" 
When you log on to Outlook, your Inbox folder appears**, and any new messages you’ve received are waiting for you in bold.  Double-click on the message to open it.

**If your Outlook opens to Outlook Today, click the Inbox folder on the Outlook Bar or click the Messages link in Outlook Today.  Either of these will take you to your Inbox.
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In the open message, to read the next or previous mail message in the Inbox, click the Previous Item or the Next Item button on the Standard Toolbar.  
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Opening and Saving An Attachment XE "Opening and Saving An Attachment" 

 XE "Opening and Saving An Attachment" 
A paper clip icon beside the message represents an attachment. 
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Double-click on the attachment icon.  This will open the following Opening Mail Attachment warning window:

If the message came from within your Command, you could click on the Open It, then click OK.  If you have the program that it was created in, it will open.  

If the message came from the “outside” then it has not been virus checked, always click on the Save it to disk then click OK and save it to an appropriate folder.    By opening the attachment, you could be subjecting the Command server to viruses.
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OR

Open the message and use the Right Mouse Button.  On the shortcut menu that appears, we have several options. To use the document later, click Save As, and then save the attachment to an appropriate folder.
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Add a Signature XE "Add a Signature" 
You can automatically add a signature file that can include text and images to your email messages:

1.
Choose Tools, then select Options to open the Options dialog box and then select the Mail Format tab.

2.
Click the Signature Picker button at the bottom of the dialog box.  The Signature Picker dialog box opens.
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3.
Click the New button to open the Create New Signature window.
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4.  
Enter a name for your new signature:, then click Next to open the Edit Signature window.
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5.
In This text will be included in outgoing mail messages: box, type the text you want to include as your signature.  To change the font or paragraph format, select the text, click on the Font and/or Paragraph button making the changes that you want, then click OK.  (These options are not available if you use Plain Text as your e-mail editor.)

6.
You can attach a vCard to the signature that recipients of your e-mail can click on the vCard and dragging to their Contacts folder on their Outlook Bar.  To add a vCard, click on New vCard from Contact… and double-click on your contact information from the Global Address List.
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7.
After completing your Signature, click Finish, then OK.

8.
You will return to your Options window and you have two decisions to make—Use this Signature by default: and Don’t use when replying or forwarding.

9.
After making the decisions, click Apply.

Once you’ve created a signature and you did not make it your default, you can quickly add it to any message by choosing Insert, then Signature; all the signatures that you have created appear on the menu.  Select the signature from the list you want to use in the message you are currently composing.

Recalling a Message XE "Recalling a Message" 
You can only recall messages that have not been opened or moved to another folder.  If you want to recall a message on our network, the individual from whom you are recalling the message must be logged on.

To recall a sent message, follow these steps:

1. Click the My Shortcuts button on the Outlook Bar, and then select the Sent Items Folder.

2. Double-click to open the message that you want to recall.
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In the Message window, click the Actions menu, then click Recall This Message.  The Recall This Message dialog box opens.

4. The Delete unread copies of this message option button and the Tell me if recall succeeds or fails for each recipient box are the defaults.  Click OK.  A notice appears in the Message window (upper-left corner) informing you that you are attempting to recall this message.

5. Click File, then close the message.

6. You eventually receive a notification in your Inbox (as new mail) notifying you whether or not the recall was successful.

Using the Address Book XE "Using the Address Book" 
[image: image49.png]% Untitled - Message (Rich Test) Y |

| Ele Edt vew Insert Fomat Tooks Actions Help Sunature {7
HS|sme(Ro(me! 4|y | Bowms. 7.

Jmsjale 2 o

swedbod [FY

Subject
|

I
b iosor. | Joutook 2000 e | @ pocumentz i, [T omiied -vresen: | [ B2 B oo

Astart || 11 @ =3 ||




The Address Book contains the names of all the people connected to your server and you can create entries for these users and/or others by adding them to your Contacts.

To open your Address Book, click on the Address Book icon.
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The default to Show Names from the: is the Global Address Book (GAL), which has all of the addresses Marine Corp wide.   
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To change the defaults of our Address Book, click on the Tools menu then Options to open the Addressing window.

Here we can change the 

Show this address list first: 

RECOMMEND:  Global Address List.

Here we can change the 

Keep personal address in: 

RECOMMEND:  Contacts.

We can also change where to look for address first in the When sending mail, check names using these address lists in the following order:

RECOMMEND:  Contacts, MCRSC, Global Address List.
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Creating Distribution List XE "Creating Distribution List" 
To create a new Distribution List:

1.
Have the Address Book open, click on the File menu, and then click on New Entry
OR
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Click on the New Entry             Icon to open the New Entry window.  
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2.
Click on New Distribution List. 

3.
Click OK to open the Untitled Distribution List. 
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4.
Name your Distribution List.  

5.
Click on the Select Members button to open the Address list and add names as if you were sending a message.  

6.
Click on the Add New button to add different types of addresses i.e. Internet, Lotus Notes.

7.
When completed, click on the Save and Close button.

To use a distribution list, in your new message just type in the name of your list in the To: blank.   Addresses are populated when you click the Send button.

Out of Office Assistant XE "Out of Office Assistant" 
To turn on the Out of Office Assistant, use the following steps:

1.
Click on the Tools menu and click on Out of Office Assistant. 
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Outlook displays the Out of Office Assistant dialog box:

2.
Click on the radio button beside I am currently Out of the Office.

3.
In the AutoReply only once to each sender with the following text box, type the message you want to send.

4.
Click on OK.

Outlook enables the Out of Office Assistant.  Anyone who sends you a message will receive a reply with the text you entered.


When you return and open Outlook for the first time you are prompted with the following window:
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If you click Yes, the Out of Office Assistant is automatically turned off.  If you click No, the Out of Office Assistant reply remains.

Using AutoArchive XE "Using AutoArchive" 
Archiving items means saving your Outlook items to a file on your hard drive.  You can have Outlook archive for you at regular intervals by using AutoArchive. 

AutoArchive is a two-step procedure.  First, we turn on AutoArchive.  Secondly, we have to set the AutoArchive properties for each folder that you want to archive.

Using AutoArchive – First Procedure XE "Using AutoArchive – First Procedure" 
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You set the option in Outlook to automatically archive your mail messages periodically into files.  The AutoArchive feature cleans your Inbox for you but saves the specified messages in an archive file.

To use AutoArchive, follow these steps:

1.
Choose Tools, then select Options.  The Options dialog box appears.

2.
Click the Other tab.

3.
Click the AutoArchive button to display the AutoArchive options.

4.
Choose from the following check box options:
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AutoArchive Every x Days—Enter a number for how often (in days) you want Outlook to automatically archive items.  If you enter 14, for example, when you start Outlook on the fourteenth day, it automatically archives the contents of your folders into an archive file.

· Prompt Before AutoArchive—If you check this, Outlook displays a dialog box each time it is about to perform the AutoArchive; you can click OK to continue or Cancel to stop the operation.

· Delete Expired Items When AutoArchiving (Email Folders Only)--Check this box to have Outlook delete messages from the Inbox after archiving them.

5.
In the Default Archive File text box, enter a path to where you want to save the file, and name it (if you choose the default notice where it is).

6.
Click OK to close the AutoArchive dialog box.  Click OK to close the Options dialog box.

Using AutoArchive for Individual Folders – Second Procedure XE "Using AutoArchive for Individual Folders – Second Procedure" 
In addition to setting the AutoArchive options in the AutoArchive dialog box, you need to change the AutoArchive options for each folder. Several Outlook folders are set up with AutoArchive turned on. These folders and their default aging periods are Calendar (6 months), Tasks (6 months), Journal (6 months), Sent Items (2 months), and Deleted Items (2 months). Inbox, Notes, Contacts, and Drafts do not have AutoArchive activated automatically.
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 To set an individual folder’s AutoArchive options and/or change the default aging period, follow these steps:

1.
Right-click on the folder in the Outlook Bar to display the shortcut menu or right-click on the folder in your Folder List.

2.
Glide down and choose Properties.  The folder’s Properties dialog box appears.

3.
Choose the AutoArchive tab.
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4.
To enable automatic archiving of the folder, click in the checkbox to Clean out items older than and enter a number and unit of time in the next boxes.  You then need to choose one of the following:

· Move old items to:  If you want to change the location, click on Browse or accept the default.  
· Permanently delete old items.


NOTE:  If you accept the default archive folder, notice where it is.

5.
Click Apply.


6.
Click OK to close the dialog box.

Finding and Opening an Archive File XE "Finding and Opening an Archive File" 
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To open an archive file:


1.
Click on the File menu, glide to Open, and click on Personal Folders File (.pst).  
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2.
Outlook displays the Open Personal Folders Dialog box (If you did not change the folder, it should open in the default folder).
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3.
Use the Look in list and move to the location of your archived files if you did not use the default.  (Here is the default location).

4.
Double-click on the archive file you want to open.  Outlook opens the file and adds it to your Folder List with the name Archive Folders.

5.
Open the Archive Folders list.
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When you archive, your existing folder structure is maintained in your new archive file. If there is a parent folder above the folder you chose to archive, the parent folder is created in the archive file, but items within the parent folder are not archived. In this way, an identical folder structure exists between the archive file and your mailbox. Folders are left in place after being archived, even if they are empty.  
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Retrieving an Archived File XE "Retrieving an Archived File" 
To put the archived file back into your active Inbox:

1.
Right click on the message in the display list.  
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2.
Glide down and click on Move to Folder.  This opens the Move Items window

3.
Click on Inbox.

4.
Click on OK.

Closing the Archive Folders and the Folder List XE "Closing the Archive Folders and the Folder List" 

Archiving Manually XE "Archiving Manually" 
You can choose to archive one or two folders or all folders manually whenever you’re ready to create an archive file.  If you choose to do it yourself, you control exactly how and when archives are created.


To archive items manually:

1.
Choose File, then select Archive.  The Archive dialog box appears.

2.
Choose one of the following options:

· Archive All Folders According to Their AutoArchive Settings—Use this option to save archives of each folder, using the setting you select in the AutoArchive tab of the folder’s Properties dialog box.

· Archive This Folder and All Subfolders—Select this option to archive the selected folder.

3.
Enter a date in the Archive Items Older Than text box, or select a date from the drop-down calendar.

4.
In the Archive File text box, enter a path and filename with which to save the file.

5.
Click OK to archive the selected folder(s).
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Click on the Archive Folders button to open the Folder List.





Click on the Pushpin for the folder List to remain open.





3. Click on the small + sign beside the folder name to expand the Archive folder.





1.  Right click on the Archive Folders.





2.  Click on the Close “Archive Folders”.





3.  Click on the X to close the Folder List.





4.  Click on the Inbox icon to return to your Inbox to locate retrieved message.
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